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BBAABB  22  
Finishing  

Pemodelan Objek 3D   
  
 
 

 

 

2.1 Finishing Desain Objek   
Untuk bisa mempresentasikan dengan bagus dan realistis sebuah 
desain objek 3D, perlu dilakukan beberapa hal penting dalam proses 
finishing. Hal tersebut dilakukan agar tampilan gambar pemodelan 3D 
lebih bersifat komunikatif dan bernilai artistik. Finishing menggunakan 
perangkat pada AutoCAD bisa dilakukan dalam beberapa tahapan.    

Jenis finishing yang bisa Anda lakukan untuk memperindah tampilan 
gambar desain, antara lain mengganti material objek, pencahayaan 
desain, mengganti background, dan rendering desain.  

2.1.1 Mengganti Material Objek  
Mengganti material pada objek merupakan suatu upaya agar karakter 
tekstur objek bisa realistik. Sebagai contoh, jika Anda ingin menam-
pilkan sebuah permukaan objek dengan tekstur kayu, sebaiknya Anda 
mengganti material jenis kayu pada objek tersebut, sehingga  per-
mukaan objek bisa menyerupai tekstur kayu seperti aslinya.   

Metode untuk Mengganti Material Objek   

a. Pilihlah jenis bidang kerja (workspace) 3D Modeling. 

b. Buatlah objek solid 3D, misalnya seperti pada contoh Gambar 2.1 
berikut.  
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Gambar 2.1 Mempersiapkan objek yang akan diberi material 

c. Klik pada bagian material pada Tool Palettes-All Palettes, 
misalnya Flooring- Materials sample. 

 
Gambar 2.2 Tool Palettes – All Materials 

d. Pilih jenis material dengan cara klik pada lambang material,  
misalnya Finishes.Flooring.Bamboo . 

e. Klik pada objek material yang akan diberi material dengan kursor 
paintbrush. 

f. Tekan Enter.    
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Gambar 2.3 Mengganti material pada Objek 

g. Apabila sebelumnya Anda pernah mengubah meterial objek 
tersebut, akan keluar kotak dialog material – Already Exists > 
klik Save this material as a copy atau Overwrite the material.  

 
Gambar 2.4 Kotak dialog material-Already Exists   

h. Berilah material yang berbeda sesuai keinginan Anda pada objek 
3D yang lain seperti yang sudah dibahas sebelumnya. 

i. Untuk melihat hasilnya ubahlah visual styles menjadi Realistic 
dengan cara sebagai berikut.  

 Klik tab Visualize.  
 Pilih ribbon panel Visual Styles > pilih ikon Realistic.  
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Gambar 2.5 Letak Visual Style pada ribbon panel 

j. Setelah Anda mengganti visual style menjadi Realistic maka 
tekstur pada objek akan berubah seperti gambar di bawah.   

 
Gambar 2.6 Objek yang sudah diberi material 

2.1.2 Pencahayaan Desain 
Pencahayaan terhadap objek dalam AutoCAD secara default sudah 
disediakan dengan satu jenis pencahayaan yang bernana Ambient, 
yaitu sistem pencahayaan yang merata ke segala arah terhadap 
suatu permukaan objek. Namun pencahayaan dengan sistem 
tersebut belum menghasilkan hasil yang lebih realistik. Oleh karena 
itu, guna mendukung kualitas tampilan objek, AutoCAD juga menye-
diakan cahaya buatan yang berjumlah tiga jenis, yaitu:  
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Point Light 
Point light merupakan jenis pencahayaan buatan, di mana sistem 
penyinarannya merupakan pencahayaan yang bersumber dari satu 
titik dan menyebar ke segala arah. Jenis cahaya ini bisa dicontohkan 
seperti lampu bohlam. 

Distant Light   

Distant light merupakan jenis cahaya buatan yang sistem penyi-
narannya merupakan penyinaran yang hanya menuju satu arah saja. 
Jenis pencahayaan ini merupakan pencahayaan yang kekuatan   
penerangannya (intensitas) tidak tergantung dari jarak penyinaran 
tersebut. 

Spotlight   

Spotlight adalah jenis pencahayaan buatan yang sumbernya berasal 
dari satu titik saja, tetapi hasil penyinarannya berbentuk kerucut, di 
mana cahaya yang dihasilkan dalam bentuk kerucut tersebut kualitas 
gradasi cahayanya dipengaruhi oleh hotspot (bagian yang mem-
punyai intensitas paling tinggi) dan falloff (batas terluar lingkaran 
pencahayaan berbentuk kerucut). 

Metode untuk Membuat Pencahayaan 

Pada kasus ini akan dicontohkan untuk menambah pencahayaan 
dengan jenis cahaya Point Light. Adapun untuk membuat penca-
hayaan bisa dilakukan dengan cara sebagai berikut. 

a. Pastikan sudah terbuat objek solid 3D, misalnya seperti di bawah. 

 
Gambar 2.7 Objek yang akan diberi pencahayaan  
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b. Ubahlah sudut pandang Viewport menjadi Top View (tampak 
atas) untuk memulai meletakkan cahaya. 

c. Kemudian ubahlah Visual Style menjadi 3D Wireframe. 

d. Klik ikon Menu Browser .  

e. Pilih View > Render > Light > New Point Light.  

f. Akan muncul kotak dialog Lighting - Viewport Lighting Mode 
yang artinya Anda diminta untuk mematikan atau menghidupkan 
default lighting. Pilih Turn off the default ligthing (recom-
mended) untuk mematikan default light.  

 
Gambar 2.8 Kotak dialog Lighting - Viewport Lighting Mode 

g. Ketik .xy > tekan Enter.  

h. Tempatkan lampu pada denah dengan klik pada tempat tertentu, 
misalnya seperti gambar di bawah. 

 
Gambar 2.9 Menempatkan lampu pada Objek 3D  
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i. Ketik ketinggian lampu, misalnya 10 > tekan Enter. 

j. Tekan Enter untuk mengakhiri. 

k. Lakukan pengaturan beberapa parameter lampu seperti inten-
sitas, memilih color (warna) maupun shadows (bayangan) 
dengan Properties. Caranya sebagai berikut.  

 Klik Lampu yang sudah terbuat > klik kanan > pilih 
Properties. 

 Melalui bagian General carilah Name > Pointlight1.  

 Type: Point.  

 On/Off Status: On.  

 Shadows: On. 

 Intensity factor > ketik 1.00 (untuk mengubah intensitas 
pencahayaan).  

 Filter Color: □ 255,255,255.  

 Tutuplah kotak Properties dengan cara klik Close .  

            
Gambar 2.10 Shortcut menu dan kotak Properties  

l. Jika telah selesai Anda dapat mengganti sudut pandang menjadi 
SW Isometric dengan visual style Realistic. 
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2.1.3 Mengganti Background 
Background yang bisa Anda buat dengan AutoCAD pada prinsipnya 
ada tiga jenis, yaitu Solid (satu warna), Gradient (gabungan tiga 
warna), dan Image (background yang dibuat dari file image). 

Metode untuk Mengganti Background   

a. Pastikan sudah terbuat objek solid 3D, misalnya seperti di bawah. 

 
Gambar 2.11 Mempersiapkan objek untuk diganti background 

b. Ketik View > tekan Enter hingga muncul kotak dialog View 
Manager seperti di bawah. 

 
Gambar 2.12 Kotak dialog View Manager 

c. Klik tombol New > subkotak dialog New View.   
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d. Pada subkotak dialog New View > ketik nama pada View name, 
misal Background 1. 

 
Gambar 2.13 Kotak dialog New View  

e. Pada bagian Settings > tentukan jenis Visual Style.  
f. Pada bagian Background pilihlah jenis background, misalnya 

Anda pilih Solid.  

 
Gambar 2.14 Memilih jenis background  

g. Tentukanlah warnanya dengan cara klik kotak warna di bagian 
bawah Color > pilih warna, misalnya warna no. 142 > klik OK.      
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Gambar 2.15 Memilih Color 

h. Akhiri dengan klik OK > OK > kembali ke kotak dialog View 
Manager.  

 
Gambar 2.16 Kotak dialog View Manager 

i. Klik Set Current > Apply > OK. 
j. Tunggulah beberapa saat untuk melihat hasilnya di mana back-

ground sudah berganti dengan Solid (warna).  
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Gambar 2.17 Background Solid pada objek 3D 

Jika Anda ingin mengganti dengan Background Image, caranya: 
k. Ketik View > tekan Enter hingga muncul kotak dialog View 

Manager seperti di bawah. 

l. Pilih Background 1 > ubahlah pada bagian Background 
Override menjadi Image > keluar kotak dialog Background. 

      
 Gambar 2.18 Memilih Image dan kotak dialog Background 

m. Klik Browse hingga keluar subkotak dialog Select File. 
n. Pilih jenis file yang Anda inginkan, sebagai contoh pilih kategori 

All image files pada bagian Files of type hingga muncul 
beberapa file image seperti dalam contoh.   
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 Gambar 2.19 Kotak dialog Select File 

o. Pilih jenis file > Open > kembali ke subkotak Background.  

 
Gambar 2.20 Kotak dialog Background 

p. Agar posisi gambar (image) yang Anda tempatkan besarnya 
memenuhi seluruh kotak background, klik Adjust Image > keluar 
kotak dialog Adjust Background Image.  

q. Pada bagian Image position > pilih Stretch.  
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Gambar 2.21 Kotak dialog Adjust Background Image 

r. Klik OK > kembali ke kotak dialog Background > klik OK.  
s. Kembali ke kotak dialog View Manager > Set Current > Apply > 

klik OK. 

 
Gambar 2.22 Objek 3D dengan background Image 
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2.1.4 Rendering Desain 
Untuk menyempurnakan desain yang telah Anda buat agar memiliki 
ukuran image dan mempunyai kualitas gambar yang baik pada saat 
akan dicetak, maka yang diperlukan adalah melakukan pengaturan 
terhadap perangkat rendering.  

Metode Rendering Desain   

a. Pastikan file objek solid 3D yang telah Anda beri material, 
pencahayaan dan background sudah terbuka. 

b. Klik tab Output. 

c. Pilih ribbon panel Render > pilih Presentation. 

 
Gambar 2.23 Memilih Presentation untuk jenis rendering 

d. Klik tanda ikon   untuk memunculkan semua perintah 
render. Pilihlah 800 x 600 untuk memunculkan jumlah pixel 
seperti gambar di bawah. 

 
Gambar 2.24 Memilih 800 x 600 untuk ukuran output size pixel  

e. Lakukan render dengan klik ikon  pada ribbon panel Render. 
Tunggulah hingga proses rendering selesai.  
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f. Simpan hasil render yang telah jadi, caranya sebagai berikut.  

 Pada kotak dialog Render pilih menu File > Save. 

 
Gambar 2.25 Kotak dialog Render 

 Beri nama file melalui bagian File name, misalnya Render 
Objek 3D.  

 Tentukan tipe filenya melalui bagian Files of type, yaitu jenis 
Files of type: BMP(*.bmp).   

 
Gambar 2.26 Kotak dialog Render Output File 
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 Klik tombol Save > hingga keluar kotak dialog BMP Image 
Options seperti di bawah. 

 Pilih 24 Bits (16.7 Million Colors), kualitas hasil render yang 
terbaik.   

 
Gambar 2.27 Kotak dialog BMP Image Options 

 Klik tombol OK > tunggu hingga proses penyimpanan gambar 
desain selesai.  

 
Gambar 2.28 Hasil Render Background Solid  

 Untuk membuat variasi hasil desain, gantilah background 
menjadi image kemudian lakukan render dengan cara yang 
sudah dibahas sebelumnya.   
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Gambar 2.29 Hasil render background Image 

2.2 Proyeksi Gambar Model  
Proyeksi Isometri dan Perspektif merupakan jenis proyeksi pemo-
delan desain yang bisa Anda pilih untuk menampilkan hasil kreasi 
desain yang sudah Anda buat. Jenis proyeksi Isometri merupakan 
jenis proyeksi yang akan menampilkan objek 3D secara paralel (objek  
3D direkonstruksi dengan garis-garis yang sejajar). 

Sedangkan untuk jenis proyeksi perspektif, objek 3D akan ditampilkan 
dengan rekonstruksi garis-garis yang menuju ke suatu titik lenyap, 
sehingga selain bisa menghasilkan titik pandang dan jarak yang lebih 
variatif, objek yang dihasilkan akan lebih berkesan realistik. Dengan 
proyeksi perspektif memungkinkan Anda untuk menampilkan semua 
bagian objek secara detail dan jelas. 

2.2.1 Proyeksi Isometri  
Untuk membuat pandangan jenis proyeksi isometri dari desain 3D 
yang Anda buat, bisa menggunakan perangkat Ribbon Panel jika 
Anda bekerja dengan bidang kerja 3D Modelig (workspace). Pada 
ribbon panel tersebut terdapat empat pilihan pandangan 3D, yaitu         
SW Isometric, SE Isometric, NE Isometric, dan NW Isometric.    

Cara untuk membuat proyeksi Isometri pada bidang kerja 3D melalui  
Ribbon Panel bisa dilakukan dengan cara berikut.     

 Klik tab Home. 
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 Pada ribbon panel View > pilih jenis proyeksi yang Anda 
inginkan, misalnya Southwest Isometric.   

 
Gambar 2.30 Memilih Proyeksi Isometri melalui Ribbon Panel  

Sedangkan langkah untuk membuat proyeksi isometri melalui Menu 
Browser sebagai berikut. 

 Klik Menu Browser .   
 Pilih menu View > 3D Views > pilih view yang diinginkan. 

 
Gambar 2.31 Memilih proyeksi Isometri melalui Menu Browser  

Apabila Anda tidak ingin menggunakan beberapa jenis perangkat 
pengatur pandangan seperti di atas, Anda bisa menggunakan kotak 
dialog Viewpoint Presets, sehingga pengaturan sudut pandangnya 
akan lebih variatif. 
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Metode untuk Menampilkan Kotak Dialog Viewpoint Presets   

a. Klik ikon Menu Browser .  

b. Pilih menu View > 3D Views > Viewpoint Presets.   

c. Tentukan arah putaran sudut pandang maupun kemiringan sudut 
pandang terhadap objek 3D melalui bagian Set Viewing Angles.  

d. Klik langsung pada Absolute to WCS maupun Relative to UCS 
atau masukkan angka pada bagian X Axis dan XY Plane. 

e. Klik OK untuk mengakhiri pengaturan. 

 
Gambar 2.32 Kotak dialog Viewpoint Presets   

 
Gambar 2.33 Objek ditampilkan dengan proyeksi isometri  
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2.2.2 Proyeksi Perspektif 
Apabila dengan proyeksi isometri (paralel) Anda tidak bisa menam-
pilkan bagian-bagian tertentu secara jelas dan bagus, maka jenis 
proyeksi perspektif merupakan alternatif yang memungkinkan Anda 
untuk bisa membuat berbagai jenis pandangan (multi view) terhadap 
suatu objek 3D. 

Metode untuk Mengubah Jenis Proyeksi Perspektif   

a. Pastikan sudah terbuat objek 3D dan tampilkan pada bidang 3D, 
misalnya seperti gambar di bawah. 

 
Gambar 2.34 Jenis proyeksi isometric yang akan diubah perspektif   

b. Klik tab Home. 

c. Pilih ribbon panel Draw > pilih ikon Free Orbit.  

 
Gambar 2.35 Letak Free Orbit pada Ribbon Panel  

d. Akan muncul bentuk lingkaran hijau pada area gambar seperti di 
bawah. 
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Gambar 2.36 Menggunakan Free Orbit 

e. Klik kanan hingga keluar shortcut menu > pilih Perspective.  

 
Gambar 2.37 Memilih Perspective pada shortcut menu  

f. Aturlah pandangan sesuai dengan keinginan Anda, jika sudah 
sesuai klik kanan hingga keluar shortcut menu lagi > pilih Exit.  
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Gambar 2.38 Tampilan objek dengan jenis proyeksi perspektif 

g. Ulangilah hal yang sama untuk membuat pandangan yang lain.  

2.3 Jenis Visual Style    
Mode visual desain atau Visual Styles merupakan fasilitas yang 
berfungsi untuk mengontrol tampilan objek 3D di layar monitor. Visual 
Styles membantu Anda dalam memberikan gambaran objek yang 
dibuat sehingga memudahkan Anda dalam membuat desain.  

Jenis Visual Style pada AutoCAD adalah sebagai berikut.   

A. 2D Wireframe: Menampilkan objek dalam bentuk garis, biasanya 
digunakan untuk menampilkan gambar secara cepat.   

 
Gambar 2.39 Tampilan objek dengan Visual Style - 2D Wireframe 
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B. 3D Wireframe: Serupa dengan 2D Wireframe, tampilan terdiri 
atas garis-garis sehingga akan sulit membedakan antara objek 
yang berada di depan dengan objek yang berada di belakangnya. 

 
Gambar 2.40 Tampilan objek dengan Visual Style - 3D Wireframe 

C. 3D Hidden: Menampilkan objek 3D dalam bentuk outline tanpa 
memperlihatkan garis-garis tersembunyi sehingga Anda dapat 
melihat bentuk objek secara utuh. 

 
Gambar 2.41 Tampilan objek dengan Visual Style - 3D Hidden 
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D. Conceptual: Memperlihatkan objek 3D dengan shading (warna) 
berupa penambahan warna, banyangan, dan tingkat gradasi 
warna. 

 
Gambar 2.42 Tampilan objek dengan Visual Style - Conceptual 

E. Realistic: Menampilkan objek 3D dengan shading (warna) yang 
smooth dan juga menampilkan material yang kita tempatkan pada 
objek.  

 
Gambar 2.43 Tampilan objek dengan Visual Style - Realistic 
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Metode untuk Mengubah Visual Style   

a. Pastikan sudah terbuat objek 3D dan tampilkan pada bidang 3D, 
misalnya seperti gambar di bawah. 

 
Gambar 2.44 Objek 3D yang akan diganti Visual Style  

b. Klik tab Visualize. 
c. Pilih ribbon panel Visual Styles > pilih ikon Conceptual. 

 
Gambar 2.45 Letak visual styles pada ribbon panel 

d. Amati perubahan tampilan bidang kerja (workspace).  
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Gambar 2.46 Visual Style menjadi Conceptual 

Selain dengan ribbon panel, Visual Style dapat diubah melalui Menu 
Browser, caranya sebagai berikut. 

a. Klik ikon Menu Browser . 
b. Pilih menu View > Visual Styles > Conceptual. 

 
Gambar 2.47 Visual styles pada Menu Browser  
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2.4 Presentasi Interaktif  
Apabila dengan proyeksi isometric (paralel) dan proyeksi perspektif 
Anda tidak bisa menampilkan bagian-bagian tertentu secara jelas dan 
bagus, maka Anda bisa menggunakan perangkat Continuous Orbit 

 untuk membuat jenis animasi interaktif (memutar objek 
3D). Perangkat tersebut juga bisa Anda akses dari Ribbon Panel.  
 
Metode untuk Membuat Animasi Interaktif   

a. Pastikan sudah terbuat objek 3D, tampilkan pada bidang 3D, 
misalnya seperti gambar di bawah. 

 
Gambar 2.48 Objek 3D yang akan dibuat animasi interaktif 

b. Klik tab Home. 

c. Pilih ribbon panel Draw > pilih ikon Continuous Orbit 
.   

 
Gambar 2.49 Letak Continuous Orbit pada Ribbon Panel  
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d. Lakukan klik dan tahan lalu geser sesuai dengan kecepatan putar 
yang Anda inginkan hingga objek 3D berputar. 

 
Gambar 2.50 Objek 3D yang berputar 

e. Untuk menghentikan putaran > klik kanan > Exit.  

f. Jika ingin kembali ke posisi semula, Anda dapat memilih proyeksi 
isometri atau proyeksi perspektif dengan cara yang sudah diba-
has sebelumnya. 

 

 


